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ePublisher Pro

This article provides steps to change colors and replace buttons for WebWorks 
Help 5.0.

You can modify the WebWorks Help 5.0 Classic theme to change the colors of the 
toolbar frame and toolbar buttons, navigation frame and navigation tabs, and the text 
color and font of the content in the navigation frame.

Section 1: Getting Started



The following are required before beginning the steps:

1) You should have an ePublisher Pro Project or format target based on the WebWorks 
Help 5.0 format.  If you do not have a WebWorks Help 5.0-based format target, create a 
new one in Project > Manage Format Targets. Make sure this target is selected as your 
Active Format Target:

2) Select the “Classic” Theme in your Project Format Settings (Format > Format Settings).

3) Press OK.



Section 2: Creating a Project Target Override
Next, you will perform a Project Format Override, to override the default images 
which make up the WebWorks Help Classic theme, and replace them with your new 
images.

For detailed information about Project Format Overrides, please see the knowledge 
base article, “Creating Project Target Overrides”.

1) In ePublisher Pro, choose View > User Files. 

2) Navigate up one level; this directory should contain the .wep file and the Files, Data, 
Logs, and Output folders.

3) Create a new folder.

4) Name the folder Targets. 

5) Open the Targets folder, and within the Targets folder, create a new folder.

6) Create a new folder and assign it the name of the format target you have selected in 
your project (by default, the format target will be WebWorks Help 5.0).

Note:Folder names in a Target override are case-sensitive.

7) Open this format target folder (e.g. WebWorks Help 5.0). Leave this window open.

8) Download the attached file, Skins.zip, and save it into the format target folder. Right-
click on “Skins.zip” and choose “Extract to folder” using a zip program such as WinZip. 
After unzipping the file, you should have a folder in that directory called “Skins”.

Note:The image below depicts what the file hierarchy would look like expanded in Win-
dows Explorer for a project named “WWHelp_Classic” and a Format Target named Web-
Works Help 5.0.



Section 3: Identifying and modifying areas of the WebWorks Help 
interface
Using the image and the corresponding table below locate the letter/number 
combinations to identify the areas of the WebWorks Help 5.0 Classic interface you 
want to modify and the corresponding files to be modified.  All these files are located 
in the Skins folder you have unzipped.



WebWorks Help 
Area Corresponding file

A1 - toolbar 
background

toolsbg.gif

A2 - synchronize 
TOC button

sync.gif (active state), syncx.gif (inactive state)

A3 - previous topic 
button

prev.gif (active state), prevx.gif (inactive state)

A4 - next topic button next.gif (active state), nextx.gif (inactive state)

A5 - PDF button pdf.gif (active state), pdfx.gif (inactive state)

A6 - related topics 
button

related topics button - related.gif (active state), 
relatedx.gif (inactive state), relatedi.gif (inline 
icon that appears in the content pane)

A7 - print button print.gif (active state), printx.gif (inactive state)

A8 - bookmark button bkmark.gif (active state), bkmarkx.gif (inactive 
state

A9 - open book 
Contents icon

fo.gif

A10 - closed book 
Contents icon

fc.gif

A11 - page Contents 
icon

doc.gif

B1 - navigation pane 
background 

viewbg.gif

B2 - numerics/Search 
background

navbg.gif

B3 - Index, Search, 
Contents, and 
Favorites tab 
background 

btn_bg.gif (active state), btnx_bg.gif (inactive 
state)

C1 - Inactive state of 
all the tabs. 
Represented by the 
<DefaultColors> tag. 

wwhelp_settings.xml



C2 - Active state of all 
the tabs. 
Represented by the 
<SelectedColors> 
tag.

wwhelp_settings.xml

C3 - HoverText 
popup. Represented 
by the  <HoverText> 
tag, which affects the 
background, 
foreground and 
border colors of 
hovertext popups.

wwhelp_settings.xml

C4 - Highlight color 
for navigation pane 
links. Represented by 
the <AnchorColors> 
tag, which affects 
global font properties 
for  anchors and 
anchor highlighting 
for  navigation pane 
entries.

wwhelp_settings.xml

C5 - Link Color for 
navigation pane links. 
Represented by the 
<AnchorColors> tag. 

wwhelp_settings.xml

WebWorks Help 
Area Corresponding file



Locate area A1-A11 images (toolsbg.gif, sync.gif, syncx.gif, prev.gif, prevx.gif, next.gif, nextx.gif, 
pdf.gif, pdfx.gif, related.gif, relatedx.gif, relatedi.gif, print.gif, printx.gif, print.gif, bkmark.gif, bkmarkx.gif, 
fo.gif, fc.gif, doc.gif)  in the following folder:

\Skins\Classic\Files\wwhelp\wwhimpl\common\images

Locate area B1-B3 images (viewbg.gif, navbg.gif, btn_bg.gif, btnx_bg.gif) in the following folder:

\Skins\Classic\Files\wwhelp\wwhimpl\js\images

1) After locating the images, open the ones you want to modify in an image editing 
program such as Photoshop or Microsoft Paint.

2) Change the colors of the images you want to modify  

Note:Do not resize the images.

3) Save the images to replace the default images.

Note:The images are .gif, so do not change the image format to .jpg or another image for-
mat. Save the image with the exact same name and in the same directory as the default 
image you are replacing.

4) Areas C1-C5 are controlled by the wwhelp_settings.xml file. With a text editor such as 
Notepad, open the wwhelp_settings.xml file located in the following folder:
Skins\Classic\wwhelp_settings.xml

5) Locate the portion of code that corresponds to the WebWorks Help Classic area you 
want to modify

6) Replace the color HEX values with the color HEX values you want to use. 
There are many online resources that will help if you do not know what color HEX values you want. Here is 
one resource: 

http://hotwired.lycos.com/webmonkey/reference/color_codes/

Areas C1 and C2 (described in the image and table above)

<Tabs>

   <DefaultColors foreground="#666666" /> <!-- C1 -->

   <SelectedColors foreground="#FFFFFF" /> <!-- C2 -->

 </Tabs>

Area C3  (described in the image and table above)

<HoverText enable="true">

<Font style="font-family: Verdana, Arial, Helvetica,

sans-serif ; font-size: 8pt" />

<Colors foreground="#000000" background="#FFFFCC"

border="#999999" />

<Size width="150" />

</HoverText>

Areas C4 and C5 (described in the image and table above)

The AnchorColors HEX value for highlight controls the highlight color of the selected entry; the enabled 
value controls the link color; the disabled value controls the color of entries that do not link to anything.

http://hotwired.lycos.com/webmonkey/reference/color_codes/


<JavaScript>

<Font style="font-family: Verdana, Arial, Helvetica, sans-serif ; 
font-size: 8pt" />

<Indent value="17" />

<AnchorColors highlight="#CCCCCC" enabled="#315585" disabled="black" /
>

Note:The rest of the Implementations section is for overriding the global font settings 
specified in the code block above, for each content pane (Contents, Index, Search and Favor-
ites tabs) individually.

7) Save wwhelp_settings.xml.

8) Regenerate the project (Project > Regenerate All).
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The purpose of this article is to describe how to create a custom 
WebWorks Help 5.0 theme by adjusting the color of the images used to 
build this output format.

Several different themes are offered by ePublisher Pro, but if none of the 
color schemes suits your needs, you can modify an existing theme to get 
the look you require.  You’ll want to follow these steps:

1) “Create a New Theme” on page 1

2) “Modify the Theme’s Images” on page 4

3) “Apply the Changes to Your Project” on page 5

Create a New Theme
A theme controls the colors, fonts, and buttons of a WebWorks Help 5.0 
layout, so the first step is to copy the necessary files from an existing 
theme.

1) In your ePublisher Pro installation directory, navigate to the following 
folder:

ePublisher Pro\Formats\WebWorks Help 5.0\Skins\

2) Select the theme for which you’d like to change the colors and/or buttons.  
To give you a starting point, the theme layouts installed with ePublisher 
Pro are:

Classic



Aero

Architect

Freeform



Lobby Blue



3) Create a copy of the chosen skin’s folder (the following example is based 
on the Lobby Blue theme) and rename it using the name you’d like to give 
to the new theme.

4) The folder should contain all the files required to build a WebWorks Help 
5.0 theme.

Modify the Theme’s Images
Since the colors of all the tabs, buttons, and panels are determined by 
images, you’ll have to adjust the color of those images to change the look 
of your theme.  To accomplish this, you’ll need a graphics editing 
application that allows you to adjust the hue of an image.  For this 
example, we used Adobe Photoshop Elements 2.0; consult your 
application’s documentation for more information.  

Note:To change the look of the text in your layout, see “Customizing Tabs and 
Panels in WebWorks Help 5.0” on page 1.

1) Navigate to:

Skins\My_Theme\Files\wwhelp\wwhimpl\js\images

2) For each GIF image in the folder,

a) Open the file in your image editing software application.

b) Adjust the color (hue/saturation/lightness) as desired.  For best 
results, change each setting by the same value for each image.



c) Save and close the GIF file

3) Navigate to:

\Skins\My_Theme\Files\wwhelp\wwhimpl\common\images\

4) Repeat Step 2 above for each image in the folder as desired.

Apply the Changes to Your Project
After creating the new theme and modifying the images to reflect the color 
scheme you’d like to use, you can integrate your custom theme into the 
settings of any WebWorks Help 5.0-based project.

1) Save and close your ePublisher Pro project.

2) Perform a Project Target Override on a file called wwhelp_settings.fti, 
located by default in the ePublisher Pro installation directory, here:

ePublisher Pro\Formats\WebWorks Help 5.0\Transforms

Note:See “Creating Project Target Overrides” on page 1 for details on this 
procedure.



3) When wwhelp_settings.fti is copied correctly into your project directory, 
open it in a text editor, such as NotePad.

4) In the <Class name=”wwhelp-skin”> section, add a new item for the 
theme you have created.  For example:
<Item value="My_Theme" stringid="wwhelp-theme-my-theme" />

5) Save and close wwhelp_settings.fti.
6) Open your project in ePublisher Pro.

7) Choose Project >> Format Settings.

8) Pull down the selection box for the “Theme” setting and choose your new 
theme.

9) Click OK to close the Format Settings dialog.

10) Regenerate your project to apply the changes.

To define text attributes (font, color, size, etc.) for your new theme, modify 
wwhelp_settings.xml, as describe in “Customizing Tabs and Panels in 
WebWorks Help 5.0” on page 1.



Customizing Tabs and Panels in WebWorks Help 5.0
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ePublisher Pro

The purpose of this article is to explain how to modify the appearance 
of the tabs and panels in WebWorks Help 5.0

If you would like to change the font and colors for the tabs and panels in 
WebWorks Help 5.0, you will need to make changes in the 
wwhelp_settings.xml file.You will need to make sure you perform a 
project target override on this file before proceeding with this article. For 
more information on this procedure, please see “Creating Project Target 
Overrides”. 

This article will walk you through the different settings you can modify to 
change the appearance of WebWorks Help 5.0 based on the settings in the 
wwhelp_settings.xml file. 

Note:By default, the wwhelp_settings.xml file is in the directory C:\Program 
Files\WebWorks\ePublisher Pro\Formats\WebWorks Help 5.0\Skins\[SKIN 
NAME] where [SKIN NAME] is the name of the skin name you are using. The 
default skin name in WebWorks Help 5.0 is Lobby Blue.

Choose an element of the WebWorks Help 5.0 layout to modify:

• “Tabs Color Settings”

• “Tabs Font Settings”

• “Panels Default Settings”

• “Contents Panel Settings”

• “Index Panel Settings”

• “Search Panel Settings”

• “Favorites Panel Settings”

• “Custom Buttons & Background Colors”

Tabs Color Settings
To change the font color for the Contents, Index, Search and Favorites tab 
buttons, locate the default code below in the wwhelp_settings.xml file and 



make modifications to the color values. 

Default Code:
  <Tabs>

   <DefaultColors foreground="#666666" />

   <SelectedColors foreground="#FFFFFF" />

  </Tabs>

Modified Code Example:
  <Tabs>

   <DefaultColors foreground="lime" />

   <SelectedColors foreground="pink" />

  </Tabs>

Example Results:

Tabs Font Settings
To change the font type for the Contents, Index, Search and Favorites tab 
buttons, locate the default code below (beneath the <Implementations> tag) 
in the wwhelp_settings.xml file and make modifications using valid CSS 
font information. 

Default Code:
   <Tabs>

    <!-- <Font> overrides can be specified here -->

    <Font style="font-family: Verdana, Arial, Helvetica, sans-
serif ; font-size: 9pt ; font-weight: normal" />

   </Tabs>

Tag Attribute [value] - Description

DefaultColors foreground [any valid color value] - 
Specifies the color of all non-selected 
tabs.

SelectedColors foreground [any valid color value] - 
Specifies the color of tab that is selected 
by a user.

Tag Attribute [value] - Description

Font style [any valid CSS font information] - 
Specifies the font type for tabs.



Modified Code Example:
   <Tabs>

    <!-- <Font> overrides can be specified here -->

    <Font style="font-family: Verdana, Arial, Helvetica, sans-
serif ; font-size: 12pt ; font-weight: bold" />

   </Tabs>

Example Results:

Panels Default Settings
You can specify the default settings for all the panels or modify them 
individually. To modify the default settings for all the panels, locate the 
default code below in the wwhelp_settings.xml file and make the 
appropriate modifications.

Default Code:
 <Implementations>

  <JavaScript>

   <Font style="font-family: Verdana, Arial, Helvetica, sans-
serif ; font-size: 8pt" />

   <Indent value="17" />

   <AnchorColors highlight="#CCCCCC" enabled="#315585" 
disabled="black" />

Modified Code Example:
 <Implementations>

  <JavaScript>

Tag Attribute [value] - Description

Font style [any valid CSS font information] - 
Specifies the default font type for all 
panels.

Indent value [value in pixels] - Specifies the left 
text indent for all panels.

AnchorColors highlight [any valid color value] - 
Specifies the background color of the 
selected link for all panels.
enabled [any valid color value] - Specifies 
the link color for all panels.
disabled [any valid color value] - 
Specifies the text color for all panels.



   <Font style="font-family: Verdana, Arial, Helvetica, sans-
serif ; font-size: 10pt; font-weight: bold;" />

   <Indent value="20" />

   <AnchorColors highlight="lime" enabled="red" 
disabled="orange" />

Example Results:

Contents Panel Settings
To modify the Contents panel settings only, locate the default code below 
in the wwhelp_settings.xml file and make the appropriate modifications.

Default Code:
    <Contents>

Tag Attribute [value] - Description

Font style [any valid CSS font information] - 
Specifies the font type for the Contents 
panel only.

Indent value [value in pixels] - Specifies the left 
text indent for the Contents panel only.

AnchorColors highlight [any valid color value] - 
Specifies the background color of the 
selected link for the Contents panel only.
enabled [any valid color value] - Specifies 
the link color for the Contents panel only.
disabled [none] - This option is not 
applicable in the Contents panel since 
there is no text and only links.



     <!-- <Font>, <Indent>, and <AnchorColors> overrides can be 
specified here -->

    </Contents>

Modified Code Example:
    <Contents>

     <Font style="font-family: Verdana, Arial, Helvetica, sans-
serif ; font-size: 10pt; font-weight: bold;” />

     <Indent value="25" />

     <AnchorColors highlight="lime" enabled="red" 
disabled="orange" />

    </Contents>

Example Results:

Note:The color orange does not appear in the output results because there 
are only hyperlinks in the TOC and there is not simple text, so the disabled 
attribute is not applicable in the Contents panel.

Index Panel Settings
To modify the Index panel settings only, locate the default code below in 
the wwhelp_settings.xml file and make the appropriate modifications.

Tag Attribute [value] - Description

Font style [any valid CSS font information] - 
Specifies the font type for the Index panel 
only.

Indent value [value in pixels] - Specifies the left 
text indent for the Index panel only.



AnchorColors highlight [any valid color value] - 
Specifies the background color of the 
selected link for the Index panel only.
enabled [any valid color value] - Specifies 
the link color for the Index panel only.
disabled [any valid color value] - 
Specifies the text color for the Index panel 
only.

SectionNavigation threshold [any integer] - Specifies the number 
of index entries in the Index before the Index 
uses separate pages for each navigation link.
separator [character separator] - Specifies the 
character that separates the Index navigation 
links.

Font style [any valid CSS font information] - 
Specifies the font type for the Section 
Navigation area of the Index panel.

CurrentColor value [any valid color value] - Specifies 
the color of the selected link letter in the 
Section Navigation area of the Index 
panel.

AnchorColors highlight [none] - This option is not 
applicable in this section of the Index 
panel since there is the CurrentColor tag.
enabled [any valid color value] - Specifies 
the navigation link color in the Section 
Navigation area of the Index panel.
disabled [any valid color value] - 
Specifies the navigation text color in the 
Section Navigation area of the Index 
panel.

Tag Attribute [value] - Description



Default Code:
    <Index>

     <!-- <Font>, <Indent>, and <AnchorColors> overrides can be 
specified here -->

     <SectionNavigation threshold="500" separator=" - ">

      <Font style="font-family: Verdana, Arial, Helvetica, sans-
serif ; font-size: 7pt ; font-weight: bold;" />

      <CurrentColor value="black" />

      <AnchorColors highlight="#CCCCCC" enabled="#315585" 
disabled="#999999" />

     </SectionNavigation>

    </Index>

Modified Code Example:
    <Index>

     <Font style="font-family: Verdana, Arial, Helvetica, sans-
serif ; font-size: 10pt; font-weight: bold" />

     <Indent value="5" />

     <AnchorColors highlight="lime" enabled="red" 
disabled="orange" />

     <SectionNavigation threshold="10" separator=" * ">

      <Font style="font-family: Verdana, Arial, Helvetica, sans-
serif ; font-size: 12pt ; font-weight: bold" />

      <CurrentColor value="aqua" />

      <AnchorColors highlight="pink" enabled="purple" 
disabled="yellow" />

     </SectionNavigation>

    </Index>

Example Results:

Note:The color pink for the attribute highlight does not appear in the output 
results. This option is not applicable in this section of the Index panel since 
there is the CurrentColor tag.



Search Panel Settings
To modify the Search panel settings only, locate the default code below in 
the wwhelp_settings.xml file and make the appropraite modifications

Default Code:
    <Search resultsbybook="true">

     <!-- <Font> and <AnchorColors> overrides can be specified 
here -->

    </Search>

Modified Code Example:
    <Search resultsbybook="false">

     <Font style="font-family: Verdana, Arial, Helvetica, sans-
serif ; font-size: 8pt" />

     <AnchorColors highlight="lime" enabled="red" 
disabled="orange" />

    </Search>

Example Results:

Tag Attribute [value] - Description

Search resultsbybook [true, false] - Specifies 
whether the search results displays the 
results by book.

Font style [any valid CSS font information] - 
Specifies the font type for the Search 
panel only.

AnchorColors highlight [any valid color value] - 
Specifies the background color of the 
selected link for the Search panel only.
enabled [any valid color value] - Specifies 
the link color for the Search panel only.
disabled [none] - This feature is not 
currently working.



Favorites Panel Settings
To modify the Favorites panel settings only, locate the default code below 
in the wwhelp_settings.xml file and make the appropriate modifications.

Default Code:
    <Favorites>

     <!-- <Font> and <AnchorColors> overrides can be specified 
here -->

    </Favorites>

Modified Code Example:
    <Favorites>

     <Font style="font-family: Verdana, Arial, Helvetica, sans-
serif ; font-size: 8pt" />

     <AnchorColors highlight="lime" enabled="red" 
disabled="orange" />

    </Favorites>

Tag Attribute [value] - Description

Font style [any valid CSS font information] - 
Specifies the font type for the Contents 
panel only.

AnchorColors highlight [any valid color value] - 
Specifies the background color of the 
selected link for the Favorites panel only.
enabled [any valid color value] - Specifies 
the link color for the Favorites panel only.
disabled [none] - This option is not 
applicable in the Favorites panel since 
there is no text and only links.



Example Results:

Note:The disabled attribute is not applicable here because there are only 
hyperlinks and not simple text.

Custom Buttons & Background Colors
If the themes included with ePublisher Pro don’t give you the look you 
want for your WebWorks Help 5.0 output, you can create a custom theme 
by modifying the color of the images used to build the format.  See 
“Creating a Custom Theme for WebWorks Help 5.0”.
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The purpose of this article is to explain the function of wwhelp_books.xsl and 
how to modify it to achieve certain appearance effects. 

This XSL file is called by the ePublisher Pro engine during a WebWorks Help 5.0 
transform.  It is instrumental in organizing the top-level groups in a project and it is 
responsible for creating the books.xml file that controls certain aspects of how the 
output for each group is displayed.

Editing wwhelp_books.xsl
To build a Table of Contents, your output is organized into books based on the top-
level groups specified in the Document Manager.  wwhelp_books.xsl uses settings 
defined by the user to name and display these books.

Note:Before you begin making changes outside the GUI, you must first perform a project for-
mat override on wwhelp_books.xsl.  For more information, see Creating Project Target Over-
rides.  The default location of wwhelp_books.xsl is in the ePublisher Pro installation directory 
\ePublisher Pro\Formats\WebWorks Help 5.0\Transforms\

You can make the following changes to your output by editing wwhelp_books.xsl.  
Click on each to view an explanation and a procedure.

• Define the Text in the browser title bar when your help system is first launched

• Specify whether a book is shown for the top-level group(s)

• Specify whether top-level books are expanded when your help system is launched

Define the Text in the browser title bar when your help system is first launched
By default, the text in the title bar is derived from the name of the top-level group for single-group projects, 
and from the “Merge Title” setting in the Merge Settings dialog box (Format>>Merge Settings) for 
projects with multiple top-level groups.

To change the title for a single-group project
You may specify browser title text for a project by changing the name of the top-level 
group in the Document Manager.  You may also assign a unique title by making a 
change in wwhelp_books.xsl.  This is helpful if, for example, you want to use 
stationery to define the title text for multiple projects.  Follow these steps to change the 
title text:

1) Open the copy of wwhelp_books.xsl created with the project format override 
above.



2) Find the following line of code:

<wwhbooks:WebWorksHelpBooks version="5.0" name="{$VarTitle}" 
expandalltopentries="false" showbooks="false">

3) Replace the value {$VarTitle} with your desired title text.

Example:

<wwhbooks:WebWorksHelpBooks version="5.0" name="New Title Text" 
expandalltopentries="false" showbooks="false">

4) Save wwhelp_books.xsl and Regenerate your output.

Result:

Text of browser window is replaced

To change the title for merged help (more than one group)
You may specify browser title text for a merged help project by changing the “Merged 
Title” setting in Merge Settings.  If no title is specified by the user, the name of the 
project format will be used as the title (example: “WebWorks Help 5.0”). You may also 
assign a unique title by making a change in wwhelp_books.xsl.  This is helpful if, for 
example, you want to use stationery to define the title text for multiple projects.  Follow 
these steps to change the title text:

1) Open the copy of wwhelp_books.xsl created with the project format override 
above.

2) There are two ways to change the title text:

a) To change the title used if no value exists in Merge Settings:

• Find the following line of code:
<xsl:value-of select="wwprojext:GetFormatName()" />

• Replace the value wwprojext:GetFormatName() with your desired title text, 
surrounded by single quotes.

Example:



<xsl:value-of select="‘My Merged Title’" />

a) To change the title and override any value in Merge Settings:

• Find the following line of code:
<wwhbooks:WebWorksHelpBooks version="5.0" 
name="{$VarMergeTitle}" expandalltopentries="false" 
showbooks="true">

• Replace the value {$VarMergeTitle} with your desired title text.
Example:

<wwhbooks:WebWorksHelpBooks version="5.0" name="My Merged 
Title" expandalltopentries="false" showbooks="true">

2) Save wwhelp_books.xsl and Regenerate your output.

Result:

Text of browser window is replaced.

Specify whether a book is shown for the top-level group(s)
For a project with only one top-level group, the book created for that group is hidden by default, and the 
contents of that group are displayed.  A project with merged output will display a book for each top-level 
group by default.  This setting can be toggled by editing wwhelp_books.xsl.

To show a book for a single top-level group
You may wish to display a single book in the TOC of your help set.  This can be helpful 
if you want to give your users a simple starting point from which to navigate.

1) Open the copy of wwhelp_books.xsl created with the project format override 
above.

2) Find the following line of code:

<wwhbooks:WebWorksHelpBooks version="5.0" name="{$VarTitle}" 
expandalltopentries="false" showbooks="false">

3) Change the value of the attribute showbooks from false to true.

4) Save wwhelp_books.xsl and Regenerate your output.



Result:

A book is shown for the single top-level group

To hide the top-level books in a merged help system
If you have several groups in the Document Manager, you may not want them to 
appear as separate books in the TOC of your output.  This can be helpful if you use 
groups for organizational purposes only and want your output to flow together 
seamlessly.

1) Open the copy of wwhelp_books.xsl created with the project format override 
above.

2) Find the following line of code:

<wwhbooks:WebWorksHelpBooks version="5.0" name="{$VarMergeTitle}" 
expandalltopentries="false" showbooks="true">

3) Change the value of the attribute showbooks from true to false.

4) Save wwhelp_books.xsl and Regenerate your output.

Result:



The book for each top-level group is hidden

Specify whether top-level books are expanded when your help system is launched
By default, the TOC is collapsed, listing the table of contents level 1 as defined in the Style Designer.

TOC books are collapsed by default

It is possible to launch your help set with all the top-level books expanded by editing wwhelp_books.xsl. 
This setting can be applied to projects with one or more groups, and it will only affect the uppermost books in 
the TOC hierarchy.

To expand all top entries in a single-group project
If an ePublisher Pro project has a single top-level group, then the book for that group 
is hidden and its contents become the top level of the TOC.  If you wish to display this 
book, see Specify whether a book is shown for the top-level group(s).  Follow 
these steps to expand the top-level books that are displayed:

1) Open the copy of wwhelp_books.xsl created with the project format override 
above.

2) Find the following line of code:

<wwhbooks:WebWorksHelpBooks version="5.0" name="{$VarTitle}" 
expandalltopentries="false" showbooks="false">

3) Change the value of the attribute expandalltopentries from false to true.

4) Save wwhelp_books.xsl and Regenerate your output.

Result:



Top-level books are expanded upon launch

To expand all top entries in a merged help project
If an ePublisher Pro project has multiple top-level groups, then a book is shown for 
each one.  If you wish to hide these books, see Specify whether a book is shown 
for the top-level group(s).  Follow these steps to expand the top-level books that are 
displayed:

1) Open the copy of wwhelp_books.xsl created with the project format override 
above.

2) Find the following line of code:

<wwhbooks:WebWorksHelpBooks version="5.0" name="{$VarMergeTitle}" 
expandalltopentries="false" showbooks="true">

3) Change the value of the attribute expandalltopentries from false to true.

4) Save wwhelp_books.xsl and Regenerate your output.

Result:



Top-level books are expanded upon launch

Summary
After performing a project format override, wwhelp_books.xsl can be edited to 
produce several common changes to the default appearance of your WebWorks Help 
5.0 output.  These changes are summarized as follows:

For Single-Group Projects

Default Code Edit Effect

<wwhbooks:WebWorksHelpBooks 
version="5.0" 
name="{$VarTitle}" 
expandalltopentries="false" 
showbooks="false">

name="New Title Text" Browser window title will 
be “New Title Text” when 
help system is launched

expandalltopentries="true" When help system is 
launched, top-level books 
in the TOC are expanded.

showbooks="true" Displays a book for the 
top-level group.



For Multiple-Group Projects

Default Code Edit Effect

<wwhbooks:WebWorksHelpBooks 
version="5.0" 
name="{$VarMergeTitle}" 
expandalltopentries="false" 
showbooks="true">

name=”My Merged Title” Browser window title will 
be “My Merged Title” when 
merged help system is 
launched

expandalltopentries="true" When merged help 
system is launched, top-
level books in the TOC are 
expanded.

showbooks="false" Hides the top-level books 
in merged output.
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The purpose of this article is to explain the WebWorks Help 5.0 search engine 
and the user-defined settings for customizing search results.

We use a third-party search engine to compile and return search results in WebWorks 
Help 5.0 output.  However, there are several markers you can add and XML files you 
can modify to get the search behavior you’re looking for in your particular project.

How does it work?
The Search function of WebWorks Help 5.0 searches an index of words compiled from 
all topics in a book (or over several books in a merged help set).  It assigns a value to 
each match according to where in the document the matching word or phrase is found.  
By default, the highest values are given to matches from keyword markers and main 
headings.  Smaller values are assigned to lower-level headings and body text.  After 
adding the match values for each document, it assigns rankings based on how each 
topic's score compares to the highest score returned.

Table 1: Default Search Weights

Document Element Search 
Score

Keyword marker 100

Document description 50

Document summary 50

Docunent Title 20

Heading1 15

Heading2 10

Caption 10

Heading3 7

Table Heading 5

H4 4



H5 4

H6 3

H7 2

All others 1

Table 1: Default Search Weights

Document Element Search 
Score



For example, a user searches for the string "media playback".  The search returns the 
following matches for either "media" or "playback":

• TopicOne - 1 title, 2 heading1, 3 body, 2 heading3

• TopicTwo - 1 keyword, 3 heading1, 6 body

• TopicThree - 2 heading1, 3 heading3, 11 body, 1 caption

According to the default scoring weights, TopicOne would score 67 (20+ 30 + 3 + 14).  
TopicTwo would score 151 (100 + 45 + 6).  TopicThree would score 72 (30 + 21 + 11 
+ 10).  Therefore, the rankings (percentages of the highest score) would display to the 
user as:

1. TopicTwo - 100%

2. TopicThree - 48%

3. TopicOne - 44%

That's the basic principal behind the search logic.  You can configure the behavior of 
the search function (including adding or adjusting score values) by performing a 
format or target override on a file located in the ePublisher Pro installation directory 
here:

Formats\WebWorks Help 5.0\Transforms\wwhelp_files.xml

That file also contains some more notes and information on the variables you can 
change to achieve the desired results.  

Also, you can add increased functionality to your searches by defining search 
synonyms, which will score matches when a similar word or phrase is encountered.

Note:For information on performing project target overrides, please see Creating Project Tar-
get Overrides.

Keyword Markers
You can increase the search score of a particular article by inserting markers 
containing the most relevant search terms for that topic.  This will ensure that when a 
user searches for a particular word, your designated topic will appear higher in the list 
of results.  Follow these steps:

1) In your FrameMaker document, create a new marker called “Keyword.”

2) Insert a new Keyword marker anywhere in your topic.

3) Add keywords to the marker text that will have the most relevance to the particular 
article in a text search.  Separate terms with a comma.

4) Insert the marker and save your document.

5) In your ePublisher Pro project, scan the document(s).

6) In the Style Designer, ensure the Marker type value for the Keyword marker is set to 
“Keywords.”



7) Regenerate output to apply the changes.

Synonyms
By defining a list of synonyms, you can increase the effectiveness of a search by 
grouping similar words together as a single result.  For example, you define movie, 
video, and avi as synonyms.  If a user searches for one of those terms, a match will be 
scored if any of the three are found in a document.

To add these definitions, you’ll need to perform an override on a file called 
synonyms.xml, located by default in the ePublisher Pro installation directory here:

\Formats\WebWorks Help 5.0\Files\wwhdata\common\

Once the file is copied to the correct location in your project directory, open it in any 
text- or XML-editing application (e.g., NotePad), and add entries to the 
<WebWorksSynonyms> section.  For example, your synonyms might look like this:

  <WebWorksSynonyms>

   <Word value="movie">

    <Synonym value="avi" />

    <Synonym value="video" />

   </Word>

   <Word value="picture">

    <Synonym value="image" />

    <Synonym value="graphic" />

    <Synonym value="photo" />

   </Word>

  </WebWorksSynonyms>

Note:The Synonyms feature does not recognize multiple word values or synonyms.  And, it 
ignores words (and synonyms) of 2 letters or less.  Also, its search logic is quite literal.  That is, 
it finds only what you type, and only if the exact form is in the text.  For example, it does not 
find plurals or phrases, and it even includes punctuation.

Minimum word length & common words
When performing a text search, the WebWorks Help 5.0 search engine follows a 
couple of guidelines designed to make the search more efficient and the results more 
helpful.  By default, the minimum length of a word in the search results is 3 letters.  
ePublisher Pro also comes with a list of terms which appear commonly in many types 
of documents, and are therefore left out of search results.  You can modify both the 
minimum length and the list of common words by performaing a target override on a 
file called locales.xml, located by default in the ePublisher Pro installation directory, 
here:

Formats\Shared\common\locale

Note:For tips on performing the override, see Creating Project Target Overrides.



Note:Because this file is in the Shared formats directory, your project folder hierarchy 
should look like this:
MyProject\Targets\MyWWHelpTarget\Shared\common\locale

Minimum length
To change the minimum number of letters in a WebWorks Help 5.0 search result:

1) Open locales.xml in an XML- or text-editing application (e.g., NotePad).

2) Find the Locale used by your project (default English is “en”).

3) Under the <Search> section, change the MinimumWordLength value to the desired 
number of characters in the shortest word the search should return.

Common words to skip
To change the list of words which will not be returned in a WebWorks Help 5.0 search:

1) Open locales.xml in an XML- or text-editing application (e.g., NotePad).

2) Find the Locale used by your project (default English is “en”).

3) Under the <Search> section, modify the <StopWords> values to reflect the list of 
words which should not appear in your project’s search results.
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This article describes the most recent API module for the WebWorks Help 5.0 
output format.

Background
Software applications can call a context-sensitive WebWorks Help topic either by 
using a standard URL or by using the WebWorks Help API. Using the API instead of 
simple URLs gives the developer increased flexibility and enhanced control. Benefits 
of using the API include the following:

• The API automatically determines the user's default browser and opens it to display the 
correct Help topic.

• The API reduces the amount of code software developers must write in order to integrate 
context-sensitive Help. Without the API, developers must code their own COM interface to 
communicate with Internet Explorer on the Windows platform. Full source code is provided 
as part of the WebWorks Help API.

• Using the API can significantly reduce the time required to load an individual topic if the 
Help system is already open in the browser window. If your application calls a topic using 
a URL instead of the API, the entire frameset, including the WebWorks Help applet, is 
loaded each time the user invokes Help. If the application calls a topic using the API, and 
the correct helpset is already loaded in the browser window, neither the frameset nor the 
applet is reloaded; instead, the topic frame is used to display the correct Help topic. This 
results in a significant performance improvement for users of your WebWorks Help sys-
tem.

• It is now possible to call the API from .NET, and we include examples to do so from C# 
and Visual Basic. Features in this API package include a DLL and COM object for the Win-
dows platform, examples and projects to build them, as well as documentation.

Note:The most recent release of the WebWorks Help API is version 4.0.5 (09/02/2004). It is 
compatible with the WebWorks Help 4.0 format and later.  However, WebWorks Help 5.0 does 
not support Java navigation, so these options should not be implemented.  For more informa-
tion, see 

WebWorks Help using URLs
You can call a WebWorks Help system using a standard http: or file: URL. By varying 
the syntax of the URL, you can call the overall Help system, an individual topic, or the 
accessible version of the Help.

To open a WebWorks Help system, you normally call a particular URL. For example, 
you might open a WebWorks Help system from a Web server by calling the following 



URL: 

http://www.webworks.com/wwp2003/index.htm  

If the WebWorks Help system were stored in the user's local file system, you would 
use a file: URL like this: 

file:///C:/Program Files/YourApplication/Help/index.htm  

Either of these URLs would open the WebWorks Help system, displaying the splash 
screen in the topic frame. 

Opening an individual topic in the frameset view
To open a specific topic, you would call a URL like this:

http://www.webworks.com/wwp2003/
index.htm?context=user_guide&topic=project_launcher 

In this URL, the context value (user_guide) is the top-level group defined and 
uniquely identifies a particular Help system, and the topic ID (project_launcher) 
uniquely identifies a particular topic within the Help system. This URL would open 
the WebWorks Help system, displaying the appropriate topic in the topic frame. 

By adding a value to the URL, you can display a context-sensitive Help topic without 
the WebWorks Help navigation frame also being displayed. For example:

http://www.webworks.com/wwp2003/
index.htm?context=user_guide&topic=project_launcher&single=true

By including single=true, you instruct WebWorks Help to display the topic in topic 
only view.

Calling WebWorks Help using the WebWorks Help API 
WebWorks Help also incorporates an API that software developers can use to call 
context-sensitive topics in a WebWorks Help system. Using the API instead of simple 
URLs gives the developer increased flexibility and enhanced control. Benefits of using 
the API include the following: 

• The API automatically determines the user's default browser and opens it to display the 
correct Help topic. 

• The API reduces the amount of code software developers must write in order to integrate 
context-sensitive Help. Without the API, developers must code their own COM interface to 
communicate with Internet Explorer on the Windows platform. This code is provided as 
part of the WebWorks Help API. 

• Using the API can significantly reduce the time required to load an individual topic if the 
Help system is already open in the browser window. If your application calls a topic using 
a URL instead of the API, the entire frameset, including the WebWorks Help applet, is 
loaded each time the user invokes Help. If the application calls a topic using the API, and 
the correct helpset is already loaded in the browser window, neither the frameset nor the 



applet is reloaded; instead, the topic frame is used to display the correct Help topic. This 
results in a significant performance improvement for users of your WebWorks Help sys-
tem. 

The WebWorks Help API is a C/C++ API and can be used with applications written in 
C, C++, Visual Basic, and Java. 

Note:We have not yet updated the API for WebWorks Help 5.0. However, the WebWorks Help 
4.0 API can be used. Just be sure not to use any of the Java navigation options, as WebWorks 
Help 5.0 does not include the Java navigation.

API package 4.0.6 available for download
Version 4.0.5 introduced an API for Javascript to this package. The API for Javascript 
is made available for use of WebWorks Help with web applications. The API for 
Javascript includes a Javascript source file, an example and documentation.

Version 4.0.6 (December 2006) includes a minor update to work around Internet 
Explorer 7.0’s security settings which strip the query string from local URLs.  This 
“bug” prevents previous versions of the API from passing context and topic arguments 
to the WebWorks Help 5.0 output, resulting in the main entry-point file (index.html) 
being displayed instead of the requested topic page.

The WebWorks Help 4.0.6 API is available for download from our online Wiki: 

http://wiki.webworks.com/DevCenter/Projects/WebWorksHelp/WebWorksHelpAPI

The WebWorks API is written in ANSI compliant C for portability. It is intended to be 
no more than a starting point for developers implementing context-sensitive help into 
their applications, and we cannot offer support or documentation other than that 
provided here, in the Wiki article, and in the API download package.

http://wiki.webworks.com/DevCenter/Projects/WebWorksHelp/WebWorksHelpAPI
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The purpose of this article is to provide you with a resource for customizing your 
WebWorks Help output.

The online WebWorks ePublisher Pro online Help does not currently have any 
information on customizing output formats. In order to address that issue, we have 
created a PDF that will provide users with more information on WebWorks Help 5.0. 
To access this PDF, please click here.
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The purpose of this article is to explain how to disable the scroll bar at the bottom 
of the TOC pane.

Some project modifications cannot be made through the GUI so we have created this 
article to provide steps for modifying the navigate.htm file using project target 
overrides. When you create a project target override you are only overriding the 
specific file that you want to modify; you are also ensuring that these modifications 
are not lost when installing updates to ePublisher Pro. For more information on how to 
perform a project target override, please see ““Creating Project Target Overrides””.

Updating Navigate.htm:
1) Open navigate.htm file in any text editor.

2) Find the frameset below </head> section.

3)  In “<frame name="" src="../../common/html/blank.htm" scrolling="auto" 
frameborder="0">”  change the word “auto” to “no”.

4) Save the navigate.htm file.

5) Close navigate.htm.

6) Open ePublisher Pro.

7) Generate your project.
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